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Preface 
 
The Flex.Gallery application program is part of the Flex.Win suite of programs and is a tool for the 
storage and previewing of Picture Object or Dynamic Object graphic images. These images are used 
by the Flex.Builder graphical display builder to produce high quality operator interface displays used 
within Flex.View. 
 
 
Related documents 
 
The following documents are related to the use of the Flex.Gallery program. 
 
� Flex.View Getting Started, document reference number 5000-0001-0050. 
� Flex.View Help Manual, document reference 5000-0001-0040. 
� Flex.Builder Help Manual, document reference 5000-0001-0041. 
� Flex.Start Help Manual, document reference 5000-0001-0043. 
� Flex.Language Help Manual, document reference 5000-0001-0044. 
� Flex.Converter Help Manual, document reference 5000-0001-0045. 
� Flex.Report Help Manual, document reference 5000-0001-0048. 
� Flex.CFE Help Manual. Document reference number 5000-0001-0060. 
 
Software information 
 
This Help Manual describes facilities contained in the Flex.Gallery application program, version 3.1. 
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Conventions 
 
The following conventions are used throughout this document: 

 The beginning of a sequence of instructions: 
 
1, 2, 3 etc.  A set of steps in a sequence of instructions. 

 A single step in an instruction. 
 
Highlight This term defines the action of moving the cursor to illuminate an alphabetic or numeric 

character, word or phrase to initiate a procedure. 
 
OR: In a sequence of instructions the text OR: is used to indicate a choice of steps. Either 

execute the one step before the OR: or the one step after it. 
 
 
Mouse conventions 
 
Within the text the left mouse button is assumed for all mouse operations unless otherwise stated. 
 
Click Press and release the left-hand mouse button without moving the pointer. This action 

is used to select an object or perform an action. 
 
Double-click Press and release the left-hand mouse button twice in quick succession. 
 
Drag Press the left-hand mouse button without releasing it and then move the pointer.  This 

action tracks the position of the mouse pointer. The action ends when the mouse 
button is released. 

 
Press Press the left-hand mouse button without releasing it. This action is generally used to 

select an object for action. 
 
Release Release the mouse button after pressing it. This action is generally used to conclude 

an action initiated by a press or a drag. 
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1 Introduction 

Flex.Gallery is part of the Flex.Win suite of programs and is a tool for the storage and previewing of 
Picture Object or Dynamic Object graphic images. These images are used by the Flex.Builder 
graphical display builder to produce high quality operator interface displays used in Flex.View. 
  
You can use Flex.Gallery to organize your images by category and type so that it is easy to find the 
one you want. You can also add new images to or delete existing images from the Gallery. 
  
The advantage of adding images to Flex.Gallery 
  
Images that are in Flex.Gallery are more easily accessible than those that are not. As you scroll 
through the Gallery, you can see what is available at a glance. If you are looking for a specific image 
or type of image, you can zero in on it quickly by looking in a likely category. 
  
File formats Flex.Gallery can import 
  
Flex.Gallery can import and insert into your Flex.Builder Display the following types of files: 
� Windows Enhanced Metafile images with file name extensions such as .emf. 
� Windows FG Pict type Metafile images with file name extensions such as .wmf. 
� Windows Bitmap images with file name extensions such as .bmp. 
� Flex.Win Symbols from imported Flex.Win Symbol Libraries. 
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2 Using the Flex.Gallery program 

2.1 Starting the Flex.Gallery program 

 To start Flex.Gallery: 
 
� Double -click on the Flex.Gallery icon on your Desktop. 

 

 
 

OR: 

1. Click on the  button. 
 
2. Select Programs, then Flex.View, and then click on Flex.Gallery. 
 
OR: 
 
� From Windows Explorer, double-click on the FlexGallery.exe file in the C:\Program 

Files\Datac\Flex.View directory. 
 
The welcome screen will appear for an instant: 
 

 
 
Figure 1:  Flex.Gallery welcome screen 
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2.2 Flex.Gallery Application window 

When Flex.Gallery has started the Flex.Gallery application window is displayed where all operations 
are centred: 
 
 
 

 
 
 
 
 
Figure 2:  Flex.Gallery application window 
 
 
2.2.1 Title bar 
 

 
  
The title bar is located along the top of a Flex.Gallery application window. When you create a new 
Gallery or open an existing Gallery, the title bar contains the name of the application and the directory 
path for the Gallery. Double-click on the title bar to display the name of the Gallery. 
  
On the right-hand side of the title bar there are the following buttons: 
  

  Minimize button 
  

  Maximize button, or   Restore button 
  

  Close button 

Category picture thumbnails 

Category 
Hierarchy 

Title Bar 

Picture Toolbar 

Menu Bar 

Standard 
Toolbar 

Status Bar 

Selected picture 
preview and details 
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2.2.2 Status bar 
 
The status bar is displayed along the bottom of the Flex.Gallery application window. 
  

 
  
The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus. This area similarly shows messages that describe the actions of toolbar buttons as 
the pointer is moved over them. 
  
The area on the right of the status bar displays the following information: 
  

  The total number of pictures for the selected category. 
 
 
2.2.3 Toolbars 
 
Flex.Gallery toolbars provide quick and easy access to the most commonly used commands. You can 
move the toolbars to any location in the window. You can also open and close any combination of 
them to suit your needs. 
 
 
2.2.3.1 Opening and closing toolbars 
 
By default, all toolbars are open. You can open and close these toolbars whenever necessary. 

 To open a toolbar: 
 
� From the View menu, select the toolbar to open. (Open toolbars display a check mark at the left 

side). 

 To close a toolbar: 
 
� From the View menu, select the toolbar to close. (Closed toolbars do not display a check mark at 

the left side). 
 
 
2.2.3.2 Moving Toolbars 
 
You can move toolbars to any location in the window. 

 To move a toolbar: 
 
1. Position the pointer somewhere over an area of the toolbar that does not display a button or drop-

down list as shown below. 
 

 
 
If the toolbar has already been moved, point to the title bar as shown below. 
 

 
 
2. Press and hold down the left-hand mouse button while you drag the toolbar to a suitable location 

in your window. 
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3. Release the mouse button to drop the toolbar to its new location. It will remain in this new place 
until you move it again or close it. 

 
 
2.2.3.3 Standard Toolbar (View menu) 
 
The Standard Toolbar is displayed along the top of the Flex.Gallery application window. The toolbar 
provides quick mouse access to many Gallery and Category editing tools used in Flex.Gallery. 
  

Button Function 

 
New Gallery 

 
Open Gallery 

 
Save Gallery As 

 
New Category 

 
Import Category 

 
Export Category 

 
Import Flex.Win Symbol Library 

 
Edit Category Name 

 
Display Help information 

 
 
2.2.3.4 Picture Toolbar (View menu) 
 
The Picture Toolbar is displayed along the top of the Flex.Gallery application window. The toolbar 
provides quick mouse access to many Picture editing tools used in Flex.Gallery. 
  

Button Function 

 
Copy Picture(s) 

 
Paste Picture(s) 

 
Import Picture 

 
Export Picture 

 
Picture Properties 
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2.2.4 Exiting the Flex.Gallery program 

 To end your Flex.Gallery session: 
 
� From the File menu, select the Exit option. 
  
  
Note: Alternative methods of quitting the Flex.Gallery program are: 
  

� Right-click on the application's Control menu button  or on the  icon in the 
Taskbar and select Close from the pop-up menu. 

  
� Double-click the application's Control menu button. 
  
� Click the  button on the right-hand side of the title bar. 
  
� With the "Flex.Gallery" application window active, key Alt+F4. 
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2.3 Using Flex.Gallery windows 

Depending on the tasks you do, you may need know about the basic window operations when using 
Flex.Gallery. The following subjects can help you. 
 
 
2.3.1 About resizing and moving windows 
 
During the operation of Flex.Gallery, you may find it useful to reduce the size of the application 
window, and/or to move it to a different location on the screen. For example, it may be desirable to 
simultaneously view two different applications, in which case, you could reduce the size of each, and 
move each to a different side of the screen. 

 To resize a window: 
 
1. Click on the  button in the right-hand corner of the title bar in order to reduce the size of the 

window. 
  
2. Move the mouse pointer over the edge or corner of the window. The pointer becomes a double-

headed arrow. 
  
3. Drag the window border until the window is the desired size, and then release the button. 

 To move a window: 
 
� Click on and drag the window title bar. 
 
 
2.3.2 About using scroll bars 
 

 

Some of the windows used by Flex.Gallery have scroll bars. These are graphical objects 
along the side and/or bottom of a window, which can be used to move the contents of the 
window so that a different portion of the contents may be viewed. 

To scroll a line or column at a time, click on one of the small triangles in the control button of 
the scroll bar. 

To scroll a page at a time, click on the bar itself. 

To scroll to a specific portion of the display, place the cursor on the slider in the middle of the 
bar, press and hold down the select button on the mouse, and drag the slider button along 
the scroll bar, releasing the select button when the desired location is reached. 

 
 
2.3.3 About minimizing and maximizing the application window 

 To minimize the Flex.Gallery application window: 
 
� Click on the  button in the right-hand corner of the title bar.  

 
Use this command to reduce the window to an icon in your Taskbar similar to the one shown 
below. 
 

 

 To reopen (maximize) the Flex.Gallery application window: 
 
� Click on the icon in the Taskbar, or right-click on the icon and select Restore or Maximize from 

the pop-up menu. 
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2.3.4 About entering data and making choices 
 
While using Flex.Gallery you will enter data and make choices in a number of different ways. The most 
common methods are described here. For specific details of data entry refer to the help information 
corresponding to the required task. 
  
There are three buttons that appear on most data input windows: 
  
OK or Yes - If you click on OK or Yes after you have input data to a window the data is saved. 
  
Cancel or No. - If you click on Cancel or No after you have input data into a window the data is not 
saved and you are returned to the previous window. 
  
Apply - If you click on Apply after you have input data to a window the data is saved but the current 
window is not closed. You will be able to view the effect of the change on the display. 
  
Some fields have a down arrow  button. Clicking on this button will display a drop-down list of 
choices. 
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2.4 Navigating within Flex.Gallery 

2.4.1 Viewing pictures in the Gallery 
 
The main part of the Flex.Gallery application window is divided into three areas; Category hierarchy, 
Selected picture preview and details, Category picture thumbnails. 
  

 
  
Category hierarchy area: 
 
An expandable/collapsible hierarchy list of Category groups is displayed providing a simple and 
efficient method for viewing all Category group names and picture names available in the gallery. 
  

 
  
Category groups with a (+) symbol to the left of them can be expanded to show a list of picture names 
for that category. 
  

 
  
Clicking the (-) symbol next to the category group will collapse the item and hide the detail. 
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Selected picture preview and details: 
 

 
  
This area displays a preview of a selected picture and the following information: 
  
Category: The Category group. 

Name: The name for the picture. The name may be edited via the "General" tab of the 
"Picture Properties" dialog box. For details, please refer to Section 2.8.8. 

Type: Its file format type; *.emf, *.wmf, *.bmp or Flex.Win Symbol. 

Copy as: What file format type; *.emf, *.dib or Flex.Win Symbol, will be produced when copied 
ready for pasting into the Flex.Builder Display. The format type is set via the 
"Clipboard Options" window. For details, please refer to Section 2.5.3. 

 
Category picture thumbnails area: 
 

 
  
This area displays thumbnails of all the pictures available for the selected Category group. 
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2.4.2 Selecting a Category or Picture 

 To select a Category: 
 
� In the hierarchy list of Category groups, move the pointer over the required category in the 

hierarchy. The pointer will change to a hand and the selected category will be underlined and 
change to blue, click to select. The pictures for the selected Category group will be displayed in 
the picture thumbnails area. 

 To select Picture(s) using the hierarchy list of Category groups: 
 
� In the hierarchy list of Category groups, click on the (+) symbol to the left of Category name to 

show a list of pictures for that category. 
 

 
 
To select a single picture, click on and highlight required picture. 
 
To select a group of pictures that are next to each other, click on and highlight the first picture of 
the group, hold down the Shift key then click on the last picture of the group. 
 
To select individual pictures that are not next to each other, hold down the Ctrl key, and then click 
on each picture as required. 
 
To select all of the pictures within the category group, use the "Select All" command from the 
"Picture" menu. For details, please refer to Section 2.4.2.1. 

 To select a Picture using the picture thumbnails area: 
 
1. Select required Category, see above. 
  
2. In the picture thumbnails area, click on the required picture. 

 

  
 
To select a group of pictures that are next to each other, click on and highlight the first picture of 
the group, hold down the Shift key then click on the last picture of the group. 
 
To select individual pictures that are not next to each other, hold down the Ctrl key, and then click 
on each picture as required.  
 
To select all of the pictures within the category group, use the "Select All" command from the 
"Picture" menu. For details, please refer to Section 2.4.2.1. 
 
A blue square around the picture(s) will indicate that they have been selected. 
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2.4.2.1 Selecting all pictures 
 
The "Select All" option from the "Picture" menu allows you to select all the pictures in a Category 
group. This option and the Copy and Paste options are generally used to transfer pictures between 
Categories. 

 To Select All: 
 
1. Select the Category containing the pictures you want to select all. 
  
2. From the Picture menu, select the Select All option, or position the pointer over the Category 

picture thumbnails area then click right-mouse button and select Select All from the pop-up menu.  
 
Shortcut:   Keypad Ctrl+A  
 
A blue square around all the pictures will indicate that they have all been selected. 
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2.5 Flex.Gallery application preferences 

2.5.1 Options (File menu) 
 
Selecting "Options" from the "File" menu will allow you to define the Flex.Gallery Application 
preferences. 

 To access the Options menu: 
 
� From the File menu, select the Options... option. By default, the "Application" window is always 

displayed when first entering "Options".  
 
Shortcut  
 
Keys:           Ctrl+Enter 
  
An expandable/collapsible hierarchy of options is displayed down the left-hand side of this 
window. 
  

 

 To select an option: 
 
� Move the pointer over the required option in the hierarchy. The pointer will change to a hand and 

the selected option will be underlined and change to blue, click to select. The appropriate options 
window will be displayed. 
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2.5.2 Application window (File - Options menu) 
 
The Application window, as shown below, allows you to change the background color for the preview 
options and the foreground color for the Dynamic symbols. 
  

 
  
The Application window is divided into two sections; “Preview Options” and “Dynamic symbol color”. 
 
Preview Options section 
 
This sets the background color used for the image in the selected picture preview and details area of 
the Flex.Gallery application window. 

 To change the color: 
 
1. Click on the Change button. The Microsoft Windows “Color” dialog box will be displayed where 

you can now define your required color. 
  
2. After you have defined the color, click on the OK button. The selected color will now be displayed 

on the button top. 
 
Dynamic symbol color section 
 
This sets the foreground color used for Dynamic symbols. 

 To change the color: 
 
1. Click on the Change button. The Microsoft Windows “Color” dialog box will be displayed where 

you can now define your required color. 
  
2. After you have defined the color, click on the OK button. The selected color will now be displayed 

on the button top. 

 To return settings to their default parameters: 
 
� Click on the Reset to Defaults button. 
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After all changes have been made to the "Application" window, click on the Apply button followed by 
the OK button to save your changes, or click on the Cancel button to close window and not save 
changes. 
  
The Help button links you to the on-line Help and provides topics and tips to help you accomplish your 
tasks. 
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2.5.3 Clipboard Options window (File - Options menu) 
 
The Clipboard Options window, as shown below, allows you to change the format of pictures when 
copying. 
 

 
 
The Clipboard Options window is divided into three sections; "Copy Metafile as...", "Copy Bitmap as..." 
and "Copy Flex.Win Symbol as...". 
 
Copy Metafile as... section 
 
When copying a Enhanced Metafile (EMF) picture, you can choose to copy it as an Enhanced Metafile 
(EMF) formatted picture, a Device Independent Bitmap (DIB) formatted picture or a Flex.Win Symbol. 
Click on required option box. 
 
The selected choice is displayed in the selected picture preview and details area of the Flex.Gallery 
application window. 
 
Copy Bitmap as... section 
 
When copying a Device Independent Bitmap (DIB) picture, you can choose to copy it as a Device 
Independent Bitmap (DIB) formatted picture or a Flex.Win Symbol. Click on required option box. 
 
The selected choice is displayed in the selected picture preview and details area of the Flex.Gallery 
application window. 
 
Copy Flex.Win Symbol as... section 
 
When copying a Flex.Win symbol picture, you can choose to copy it as a Flex.Win Symbol or a Device 
Independent Bitmap (DIB) formatted picture. Click on required option box. 
 
The selected choice is displayed in the selected picture preview and details area of the Flex.Gallery 
application window. 
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 To return settings to their default parameters: 
 
� Click on the Reset to Defaults button. 
 
After all changes have been made to the "Clipboard Options" window, click on the Apply button 
followed by the OK button to save your changes, or click on the Cancel button to close window and 
not save changes. 
 
The Help button links you to the on-line Help and provides topics and tips to help you accomplish your 
tasks. 
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2.5.4 Language window (File - Options menu) 
 
The "Language" window, as shown below, allows you to choose and specify a product specific 
language translation for use within Flex.Gallery. These language translations are produced using the 
Flex.Language program. 
 

 
  
The "Language" window is divided into two sections; “Enable product interface language translation” 
and “Advanced settings”. 
 
Enable product interface language translation section 
 
Product specific language translations are produced using the "Flex.Language" program and saved on 
your Windows PC. For details, please refer to the Flex.Language program Help documentation. 

 To enable a Product specific language: 
 
1. Click on the Enable product interface language translation check-box. A tick will appear when 

enabled and the two options listed below will become active. Click again to disable (no tick). 
  
2. Select required option by clicking on its option-box. Choices are:  

 
Use language setting for all products: - Allows you to choose the Flex.Win default language. 
The language shown grayed out in this field is as specified in the "Default language used for all 
products" field of the "Translation Language Settings" window within the Flex.Language program.  
 
Use product specific language: - Allows you to choose a user specified language setting for use 
with Flex.Gallery.  
 
To select a language, click on the  button to the right of this field and choose required language 
from the drop-down list. 
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The character set on your PC will change to the selected language. For example, if you have 
"Spanish" and "English" character sets installed on your PC, you will be able to choose "Spanish" from 
the drop-down list. Now the character set used will be "Spanish". You are then able to construct a new 
menu or edit an existing menu in "Spanish". The same applies to all other aspects, e.g., a new text 
box in a display will be in the "Spanish" character set. 
  
Note: The "Flex.Language" program can be used to remotely set or override the "Enable product 
interface language translation" settings. 
 
Advanced settings section 
 
Selecting the Advanced settings option, tick in check-box, will reveal the I want language settings 
to affect current Windows® user only option. 
  
Selecting the I want language settings to affect current Windows® user only option, tick in check-
box, allows you to set the Flex.Gallery character set for the user currently logged onto the Windows 
PC. 
 
For example, if you were to log onto a Windows 2000 PC as "John" and opened Flex.Gallery (logged 
in as "USERA") and have selected "Spanish" as the chosen language, then the character set in 
Flex.Gallery will be Spanish. 
  
If you were to log off the Windows 2000 PC and another user logged on as "David", and opens 
Flex.Gallery (logged in as "USERA"), the character set will revert to the default character set of 
"English" and not your preferred language of "Spanish". 
  
After all changes have been made to the "Language" window, click on the Apply button followed by 
the OK button to save your changes, or click on the Cancel button to close window and not save 
changes. 
  
If you reset the language for the Flex.Gallery program, after choosing the required language from the 
drop-down list and clicking on the Apply button, the following massage will appear: 
 

 
  
You will need to restart the program before the changes can take effect. 
  
The Help button links you to the on-line Help and provides topics and tips to help you accomplish your 
tasks. 
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2.5.5 Product Info window (File - Options menu) 
 
The "Product Info" window, as shown below, displays the product information and all its components 
including information about the hardware and its operating system. 
  
From the “Product Info” window you can visit the Datac WEB site or if you have any comments or have 
any problems during the system execution, you can send us an e-mail with the "Product information". 
This will help us to define the reason of your problems and eliminate the errors. 
  

 
  

 To visit the Datac Control International Limited WEB site: 
 
� Click on the Web Server button. Your WEB browser will be opened and the Datac WEB site will 

be dialled. 

 To send us an e-mail: 
 
1. Click on the E-mail Support button. 
  
2. When prompted, say Yes to copying the contents of the Application summary into the Clipboard. 

Your e-mail application will be opened where the Datac contact addresses will be entered 
automatically. 

  
3. Paste the text from the Clipboard to your e-mail program adding information about your problems. 
  
4. Send the e-mail to us in the normal way. 
  
The Help button links you to the on-line Help and provides topics and tips to help you accomplish your 
tasks. 
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2.6 Organizing galleries 

2.6.1 Creating a new gallery 
 
The "New..." option from the "Gallery" menu allows you to create a new Gallery. 

 To create a new Gallery: 
 
1. From the Gallery menu, select the New... option.  

 

Shortcut:   Toolbar  
 
The "New Gallery" dialog box will appear. For details on how to use this dialog box, please refer to 
Section 2.6.1.1. 

  
2. Specify the location and the name for the new Gallery. The "main1" gallery supplied with the 

Flex.View program is located in the "C:/Program Files/Datac/Flex.View/images" directory.  
 
The "Files of type" will always be "Flex.Gallery gallery file (*.mbv)". 

  
3. Click on the Open button. Flex.Gallery will create a blank template for your new Gallery where you 

can start to add Categories and Pictures.  
 
In the application title bar, the directory path for the new Gallery will be displayed. Double-click on 
the title bar to display the name of the Gallery. 

 
 
2.6.1.1 New Gallery dialog box 
 

 
 
The following options allow you to specify the name and location of the file you're about to open: 
Look in: Displays the current folder and its list of available folders and files. Double-click on the folder 
you want to open. To see where the current folder is located in the hierarchy of folders, click on the  
button. The resulting drop-down box displays folders above the selected location. 
 

Go To Last Folder Visited:    Moves to the last folder you visited. 
 

Up One Level:    Moves the "Look in" folder up one level in the directory hierarchy. 
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Create New Folder:    Creates a new folder in the current directory hierarchy. 
 

View Menu:    Allows you to change the appearance of items in a folder. Click the View menu 
button, and then click on Large Icons, Small Icons, List, Details, or Thumbnails as required from 
the drop-down list. 
 
File name: Displays files of the type specified in the "Look in" box. To open a file, choose from the list, 
or type a path and filename in the box. 
 
Files of type: Displays the file types you can open, identified by their filename extension. To change 
the type, choose from the drop-down list. 
 
Open button: Opens the selected file. 
 
 
2.6.2 Opening a gallery 
 
The "Open..." option from the "Gallery" menu allows you to open an existing Gallery. 

 To open a Gallery: 
 
1. From the Gallery menu, select the Open... option.  

 

Shortcut:   Toolbar  
 
The "Open Gallery" dialog box will appear. For details on how to use this dialog box, please refer 
to Section 2.6.2.1. 

  
2. Locate the required Gallery. The "main1" gallery supplied with the Flex.View program is located in 

the "C:/Program Files/Datac/Flex.View/images" directory. 
 
3. Click on the Open button.  

 
In the application title bar, the directory path for the Gallery will be displayed. Double-click on the 
title bar to display the name of the Gallery. 

 
 
2.6.2.1 Open Gallery dialog box 
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The following options allow you to specify the name and location of the file you're about to open: 
 
Look in: Displays the current folder and its list of available folders and files. Double-click on the folder 
you want to open. To see where the current folder is located in the hierarchy of folders, click on the  
button. The resulting drop-down box displays folders above the selected location. 
 

Go To Last Folder Visited:    Moves to the last folder you visited. 
 

Up One Level:    Moves the "Look in" folder up one level in the directory hierarchy. 
 

Create New Folder:    Creates a new folder in the current directory hierarchy. 
 

View Menu:    Allows you to change the appearance of items in a folder. Click the View menu 
button, and then click on Large Icons, Small Icons, List, Details, or Thumbnails as required from 
the drop-down list. 
 
File name: Displays files of the type specified in the "Look in" box. To open a file, choose from the list, 
or type a path and filename in the box. 
 
Files of type: Displays the file types you can open, identified by their filename extension. To change 
the type, choose from the drop-down list. 
 
Open button: Opens the selected file. 
 
 
2.6.3 Saving a gallery under a new name 
 
The "Save As..." option from the "Gallery" menu allows you to overwrite an existing Gallery with a copy 
of the currently open Gallery or to save the currently open Gallery under a new name. 

 To overwrite an existing Gallery or save a Gallery under a new name: 
 
1. Open the Gallery you want to save. 
 
2. From the Gallery menu, select the Save As... option.  

 

Shortcut:   Toolbar  
 
The "Save Gallery As" dialog box will appear. For details on how to use this dialog box, please 
refer to Section 2.6.3.1 

 
3. Specify the location and the new name for the Gallery to be saved. The "Save as type" will always 

be "Flex.Gallery gallery file (*.mbv)".  
 
4. Click on the Save button.  
 

When saving the Gallery under a new name, Flex.Gallery will create a copy of the currently open 
Gallery under a new name. If the Gallery was previously saved with a different name, that version 
will remain unchanged.  
 
If you entered a name that matches another Gallery that exists in your project, then after clicked 
on the Save button, the following message will appear: 
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Click on the Yes button to overwrite the existing Gallery, or click on the No button to abort the 
operation.  
 
In the application title bar, the directory path for the Gallery will be displayed. Double-click on the 
title bar to display the name of the Gallery. 
 

 
2.6.3.1 Save Gallery As dialog box 
 

 
  
The following options allow you to specify the name and location of the file you're about to save: 
  
Save in: Displays the current folder and its list of available folders and files. Double-click on the folder 
you want to open. To see where the current folder is located in the hierarchy of folders, click on the  
button. The resulting drop-down box displays folders above the selected location. 
  

Go To Last Folder Visited:    Moves to the last folder you visited. 
  

Up One Level:    Moves the "Save in" folder up one level in the directory hierarchy. 
  

Create New Folder:    Creates a new folder in the current directory hierarchy. 
  

View Menu:    Allows you to change the appearance of items in a folder. Click the View menu 
button, and then click on Large Icons, Small Icons, List, Details, or Thumbnails as required from 
the drop-down list. 
  
File name: Displays files of the type specified in the "Save as type" box. To save a file, choose from 
the list, or type a path and filename in the box. 
  
Save as type: Displays the file types you can save as, identified by their filename extension. To 
change the type, choose from the drop-down list. 
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Save button: Saves the selected file. 
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2.7 Organizing categories 

2.7.1 Adding a new category 
 
The "New..." option from the "Category" menu allows you to add a new Category. 

 To add a new Category: 
 
1. From the Category menu, select the New... option, or position the cursor over the hierarchy list of 

Category groups then click right-mouse button and select New Category... from the pop-up menu.  
 

Shortcuts:   Toolbar    Keypad Shift+N  
 
The "New Category" dialog box will appear where Flex.Gallery offers a new Category name 
automatically. 
 

 
  
2. If you want to enter your own name for the Gallery, type over the name shown, maximum of 75 

characters including spaces, then click on the OK button. The new category will be added to the 
hierarchy list of Category groups.  
 
If you entered a name that already existed, a message will appear "Category with this name 
already exists, please enter another name", if so, click on the OK button and enter new name 
once more. 

 
 
2.7.2 Removing an existing category 
 
The "Delete" option from the "Category" menu allows you to remove an existing Category and its 
contents of pictures from the hierarchy list of Category groups. 

 To delete a Category: 
 
1. Select the Category you want to delete. 
  
2. From the Category menu, select the Delete option, or position the pointer over the Category in 

the hierarchy list of Category groups then click right-mouse button and select Delete Category 
from the pop-up menu.  
 
Shortcut:   Keypad Shift+D  
 
Flex.Gallery will then request you to confirm the removal of the category. 
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3. Click on the Yes button to confirm, or click on the No button to abort the operation. 
 
 
2.7.3 Importing a category 
 
The "Import..." option from the "Category" menu allows you to import a previously saved Category and 
its contents of pictures from file. This option and the Export... option is generally used to transfer 
categories from one Gallery to another. 

 To import a category: 
 
1. From the Category menu, select the Import... option, or position the pointer over any Category in 

the hierarchy list of Category groups then click right-mouse button and select Import Category... 
from the pop-up menu.  
 

Shortcuts:   Toolbar    Keypad Shift+F3  
 
The "Import Category" dialog box will appear. For details on how to use this dialog box, please 
refer to Section 2.7.3.1. 

  
2. Locate the required Category file. The "Files of type" will always be "Flex.Gallery category file 

(*.fgc)". 
  
3. Click on the Open button. The imported category will be added to the Hierarchy list of Category 

groups. 
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2.7.3.1 Import Category dialog box 
 

 
  
The following options allow you to specify the name and location of the file you're about to import: 
  
Look in: Displays the current folder and its list of available folders and files. Double-click on the folder 
you want to open. To see where the current folder is located in the hierarchy of folders, click on the  
button. The resulting drop-down box displays folders above the selected location. 
  

Go To Last Folder Visited:    Moves to the last folder you visited. 
  

Up One Level:    Moves the "Look in" folder up one level in the directory hierarchy. 
  

Create New Folder:    Creates a new folder in the current directory hierarchy. 
  

View Menu:    Allows you to change the appearance of items in a folder. Click the View menu 
button, and then click on Large Icons, Small Icons, List, Details, or Thumbnails as required from 
the drop-down list. 
  
File name: Displays files of the type specified in the “Files of type” box. To open a file, choose from 
the list, or type a path and filename in the box. 
  
Files of type: Displays the file types you can open, identified by their filename extension. To change 
the type, choose from the drop-down list. 
  
Open button: Opens the selected file. 
 
 
2.7.4 Exporting a category 
 
The "Export..." option from the "Gallery" menu allows you to save a Category and its contents of 
pictures to file. This option and the Import... option is generally used to transfer categories from one 
gallery to another. 

 To export a category: 
 
1. Select the Category you want to export. 
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2. From the Category menu, select the Export... option, or position the pointer over the Category in 
the hierarchy list of Category groups then click right-mouse button and select Export Category... 
from the pop-up menu.  
 

Shortcuts:   Toolbar    Keypad Shift+F4  
 
The "Export Category" dialog box will appear. For details on how to use this dialog box, please 
refer to Section 2.7.4.1. 

  
3. Specify the location and the name for the Category to be saved. The "Save as type" will always be 

"Flex.Gallery category file (*.fgc)". 
  
4. Click on the Save button. 
 
 
2.7.4.1 Export Category dialog box 
 

 
  
The following options allow you to specify the name and location of the file you're about to export: 
  
Save in: Displays the current folder and its list of available folders and files. Double-click on the folder 
you want to open. To see where the current folder is located in the hierarchy of folders, click on the  
button. The resulting drop-down box displays folders above the selected location. 
  

Go To Last Folder Visited:    Moves to the last folder you visited. 
  

Up One Level:    Moves the "Save in" folder up one level in the directory hierarchy. 
  

Create New Folder:    Creates a new folder in the current directory hierarchy. 
  

View Menu:    Allows you to change the appearance of items in a folder. Click the View menu 
button, and then click on Large Icons, Small Icons, List, Details, or Thumbnails as required from 
the drop-down list. 
  
File name: Displays files of the type specified in the "Save as type" box. To save a file, choose from 
the list, or type a path and filename in the box. 
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Save as type: Displays the file types you can save as, identified by their filename extension. To 
change the type, choose from the drop-down list. 
  
Save button: Saves the selected file. 
 
 
2.7.5 Importing a Flex.Win Symbol Library 
 
The "Import Flex.Win Symbol Library..." option from the "Category" menu allows you to import a 
Flex.Win Project Symbol Library. 

 To import a Symbol Library: 
 
1. From the Category menu, select the Import Flex.Win Symbol Library... option, or position the 

pointer over any Category in the hierarchy list of Category groups then click right-mouse button 
and select Import Flex.Win Symbol Library... from the pop-up menu.  
 

Shortcuts:   Toolbar    Keypad Shift+F5  
 
The "Import Flex.Win Symbol Library" dialog box will appear. For details on how to use this dialog 
box, please refer to Section 2.7.5.1. 

  
2. Locate the required Library file. By default, Symbol Libraries for a Project are stored in the 

"C:\Program Files\DATAC\Projects\[Project name]\setup\win\dfw\” directory.  
 
The "Files of type" will always be "Flex.Win symbol library (*.lib)". 

  
3. Click on the Open button. 
 
 
2.7.5.1 Import Flex.Win Symbol Library dialog box 
 

 
  
The following options allow you to specify the name and location of the file you're about to import: 
  
Look in: Displays the current folder and its list of available folders and files. Double-click on the folder 
you want to open. To see where the current folder is located in the hierarchy of folders, click on the  
button. The resulting drop-down box displays folders above the selected location. 
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Go To Last Folder Visited:    Moves to the last folder you visited. 
  

Up One Level:    Moves the “Look in” folder up one level in the directory hierarchy. 
  

Create New Folder:    Creates a new folder in the current directory hierarchy. 
  

View Menu:    Allows you to change the appearance of items in a folder. Click the View menu 
button, and then click on Large Icons, Small Icons, List, Details, or Thumbnails as required from 
the drop-down list. 
  
File name: Displays files of the type specified in the “Files of type” box. To open a file, choose from 
the list, or type a path and filename in the box. 
  
Files of type: Displays the file types you can open, identified by their filename extension. To change 
the type, choose from the drop-down list. 
  
Open button: Opens the selected file. 
 
 
2.7.6 Renaming a category 
 
The "Edit Name..." option from the "Category" menu allows you to rename an existing Category in the 
hierarchy list of Category groups. 

 To rename a Category: 
 
1. Select the Category you want to rename. 
  
2. From the Category menu, select the Edit Name... option, or position the pointer over the 

Category in the hierarchy list of Category groups then click right-mouse button and select Edit 
Category Name... from the pop-up menu.  
 

Shortcuts:   Toolbar    Keypad Shift+E  
 
The "Edit Category Name" dialog box will appear where the existing Category name is displayed. 
 

 
  
3. Type over the existing name by entering a new name for the category, maximum of 75 characters 

including spaces, then click on the OK button. The new category name will now be displayed in 
the hierarchy list of Category groups.  
 
If you entered a name that already existed, a message will appear "Category with this name 
already exists, please enter another name", if so, click on the OK button and enter new name 
once more. 
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2.8 Organizing pictures 

2.8.1 Adding a picture to your Flex.Builder display 
 
There are five basic steps to follow when adding a picture from the Gallery into your Flex.Builder 
display: 
  
1. Open the required Gallery. For details, please refer to Section 2.6.2. 
  
2. In the list of categories, select the category you want. For details, please refer to Section 2.4.2. 
  
3. Scroll through the gallery of pictures and select the required picture. For details, please refer to 

Section 2.4.2. 
  
4. Use the Copy Picture command to copy the picture to the Clipboard. For details, please refer to 

Section 2.8.2. 
  
5. In Flex.Builder, use the Paste command to paste the picture into the display. 
 
 
2.8.2 Copying a picture to the Clipboard 
 
The "Copy" option from the "Picture" menu allows you to copy a picture onto the Clipboard. This option 
and the Paste option is generally used to transfer pictures between Categories or is used as part of 
the process to transfer pictures from the gallery to the Flex.Builder application displays. 

 To copy a picture: 
 
1. Select the picture(s) that you want to copy. 
  
2. From the Picture menu, select the Copy option, or click right-mouse button and select Copy 

Picture from the pop-up menu.  
 

Shortcuts:   Toolbar    Keypad Ctrl+C 
  
Note: The file format for copied picture is as displayed in the picture preview area. The setting of the 
file format is defined in the "Clipboard Option" window of the "File - Options" menu. For details, please 
refer to Section 2.5.3. 
  
See also the “Cut” command, Section 2.8.3. 
 
 
2.8.3 Removing a picture using the Cut command 
 
The "Cut" option from the "Picture" menu allows you to remove pictures from the Category list and 
copy them to the Clipboard. 

 To cut pictures: 
 
1. Select the picture(s) that you want to cut. 
  
2. From the Picture menu, select the Cut option, or position the pointer over the Picture then click 

right-mouse button and select Cut Picture from the pop-up menu.  
 
Shortcut:   Keypad Ctrl+X  
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Flex.Gallery will then request you to confirm the removal of the picture. 
 

 
  
3. Click on the Yes button to confirm, or click on the No button to abort the operation. 
  
See also the “Copy” command, Section 2.8.2. 
 
 
2.8.4 Removing a picture using the Delete command 
 
The "Delete" option from the "Picture" menu allows you to remove pictures from the Category list. 

 To delete pictures: 
 
1. Select the picture(s) that you want to delete. 
  
2. From the Picture menu, select the Delete option, or position the pointer over the Category picture 

thumbnails area then click right-mouse button and select Delete Picture from the pop-up menu.  
 
Shortcut:   Keypad Del  
 
Flex.Gallery will then request you to confirm the removal of the pictures. 
 

 
  
3. Click on the Yes button to confirm, or click on the No button to abort the operation. 
 
 
2.8.5 Pasting a picture from the Clipboard 
 
The "Paste" option from the "Picture" menu allows you to paste the contents of the Clipboard into a 
Category group. This option and the Cut or Copy option is generally used to transfer pictures between 
Categories. 

 To paste picture(s) from the Clipboard: 
 
1. Select the Category that you want to paste the picture(s) into. 
  
2. From the Picture menu, select the Paste option, or position the pointer over the Category picture 

thumbnails area then click right-mouse button and select Paste Picture from the pop-up menu.  
 

Shortcuts:   Toolbar    Keypad Ctrl+V  
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The "Paste Pictures" dialog box will appear: 
 

  
 
In the "Picture's names:" area, Flex.Gallery automatically enters a default Picture name for each of 
the pictures pasted from the Clipboard. Click on and highlight the Picture name to see an image of 
the picture in the "Preview:" area.  

 
3. Click on the OK button. When the confirmation message appears to inform you that the operation 

has completed, click on the OK button and the new picture(s) will be added to the selected 
Category. 

  
To rename the pictures, please refer to Section 2.8.8.1 or 2.8.8.2. 
 
 
2.8.6 Exporting a picture 
 
The "Export..." option from the "Picture" menu allows you to save picture(s) to file. This option and the 
Import... option is generally used to transfer pictures between applications. 

 To export a picture: 
 
1. Select the picture(s) that you want to export. 
 
2. From the Picture menu, select the Export... option, or position the pointer over one of the 

selected pictures in the Category picture thumbnails area then click right-mouse button and select 
Export Picture.. from the pop-up menu.  
 

Shortcuts:   Toolbar    Keypad F4 
  
Depending on whether you selected one or more pictures for exporting, two different "Export picture" 
dialog boxes will appear: 
  
If you only selected one picture: 
  
Note: Using this method, you can rename the file. 
  
The standard "Export picture" dialog box will appear. For details on how to use this dialog box, please 
refer to Section 2.8.6.1. 
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1. Specify the location, file name and the file format for the picture to be saved.  
 
The file format in the "Save as type" field can only be *.emf, *.wmf or .bmp as displayed in the 
drop-down list. 

  
2. Click on the Save button. 
  
  
If you selected more than one picture: 
  
Note: Using this method, you cannot rename the files. 
  
The following "Export Picture" dialog box will appear: 
 

 
 
A list of file names is displayed in the "File names:" area. Click on and highlight the Picture name to 
see an image of the picture in the "Preview:" area. 
  
1. In the "Path:" field, click on the Browse button. The "Browse for Folder" dialog box will appear. 
  
2. Select required path for the files to be exported to then click on the OK button.  

 
You will be returned to the "Export Picture" dialog box where the selected path will be displayed in 
the "Path:" field. 

  
3. Click on the OK button.  

 
The following message will appear after Flex.Gallery has successfully exported the pictures. 
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4. Click on the OK button to return to the Flex.Gallery application window. 
 
 
2.8.6.1 Export Picture dialog box 
 

 
  
The following options allow you to specify the name and location of the file you're about to export: 
  
Save in: Displays the current folder and its list of available folders and files. Double-click on the folder 
you want to open. To see where the current folder is located in the hierarchy of folders, click on the  
button. The resulting drop-down box displays folders above the selected location. 
  

Go To Last Folder Visited:    Moves to the last folder you visited. 
  

Up One Level:    Moves the "Save in" folder up one level in the directory hierarchy. 
  

Create New Folder:    Creates a new folder in the current directory hierarchy. 
  

View Menu:    Allows you to change the appearance of items in a folder. Click the View menu 
button, and then click on Large Icons, Small Icons, List, Details, or Thumbnails as required from 
the drop-down list. 
  
File name: Displays files of the type specified in the "Save as type" box. To save a file, choose from 
the list, or type a path and filename in the box. 
  
Save as type: Displays the file types you can save as, identified by their filename extension. To 
change the type, choose from the drop-down list. 
  
Save button: Saves the selected file. 
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2.8.7 Importing a picture 
 
The "Import..." option from the "Picture" menu allows you to import a previously saved picture from file. 
This option and the Export... option is generally used to transfer pictures between Galleries. This 
option can also be used to import new pictures produced on an external graphics package. 

 To import a picture: 
 
1. Select the Category that you want to import the picture(s) into. 
  
2. From the Picture menu, select the Import... option, or position the pointer over the Category 

picture thumbnails area then click right-mouse button and select Import Picture.. from the pop-up 
menu.  
 

Shortcuts:   Toolbar    Keypad F3  
 
The standard "Import Picture" dialog box will appear. For details on how to use this dialog box, 
please refer to Section 2.8.7.1. 

  
3. Locate and select required Picture file(s).  

 
To select a single file, click on and highlight required file.  
 
To select a group of files that are next to each other, click on and highlight the first file of the 
group, hold down the Shift key then click on the last file of the group.  
 
To select individual files that are not next to each other, hold down the Ctrl key, then click on each 
file as required.  
 
The file format in the "Files of type" field can only be .emf, .wmf or .bmp. 

  
4. Click on the Open button.  

 
The "Import Pictures" dialog box, as shown below will appear: 
 

  
 
A list of file names is displayed in the "Picture's names:" area. Click on and highlight the Picture 
name to see an image of the picture in the "Preview:" area.  
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5. Click on the OK button.  
 
When the confirmation message appears to inform you that the operation has completed, click on 
the OK button and the new picture(s) will be added to the selected Category. 

 
 
2.8.7.1 Import Picture dialog box 
 

 
  
The following options allow you to specify the name and location of the file you're about to import: 
  
Look in: Displays the current folder and its list of available folders and files. Double-click on the folder 
you want to open. To see where the current folder is located in the hierarchy of folders, click on the  
button. The resulting drop-down box displays folders above the selected location. 
  

Go To Last Folder Visited:    Moves to the last folder you visited. 
  

Up One Level:    Moves the “Look in” folder up one level in the directory hierarchy. 
  

Create New Folder:    Creates a new folder in the current directory hierarchy. 
  

View Menu:    Allows you to change the appearance of items in a folder. Click the View menu 
button, and then click on Large Icons, Small Icons, List, Details, or Thumbnails as required from 
the drop-down list. 
  
File name: Displays files of the type specified in the “Files of type” box. To open a file, choose from 
the list, or type a path and filename in the box. 
  
Files of type: Displays the file types you can open, identified by their filename extension. To change 
the type, choose from the drop-down list. 
  
Open button: Opens the selected file. 
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2.8.8 Properties... (Picture menu) 
 
There are five ways in which you can view the "Picture Properties" dialog box: 
 
1. Select the picture, and from the Picture menu, select the Properties... option. 
 
2. Double click on the required picture. 
 
3. Select the picture, click the right-mouse button, and then select Picture Properties... from the 

pop-up menu. 
 
4. Select the picture, then key Alt+Enter. 
 

5. Select the picture, then click on the  button. 
  
Depending on the type of picture selected, the "Picture Properties" dialog box can have up to three 
tabs displayed as described below. 
 
 
2.8.8.1 General tab (EMF picture) 
  

 
  
The significance of the fields in the General tab are: 
  
Picture Name: - the name of the picture. The name may be edited by overwriting the existing name. 
  
Picture Type: - displays the file format type; "Enhanced Metafile (EMF)". 
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2.8.8.2 General tab (DIB or Flex.Win Symbol picture) 
  

 
  
The significance of the fields in the General tab are: 
  
Picture Name: - the name of the picture. The name may be edited by overwriting the existing name. 
  
Picture Type: - displays the file format type; "Device Independent Bitmap (DIB)" or "Flex.Win 
Symbol". 
  
  
2.8.8.3 Specific tab (EMF picture) 
  

 
  
The Specific tab displays details of the Metafile. 
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To view the GDI code, click on the Show GDI code records as text button. The "Metafile Records" 
dialog box will appear: 
  

 
  
From this dialog box you can copy all or part of the text to the Clipboard. This can then be pasted into 
any text editor for printing or saving to file. 

 To copy to the Clipboard: 
 
1. Select required text.  

 
To select a single line of text, click on and highlight required line.  
 
To select a group of lines that are next to each other, click on and highlight the first line of the 
group, hold down the Shift key then click on the last line of the group.  
 
To select individual lines that are not next to each other, hold down the Ctrl key, then click on 
each line as required.  
 
To select all of the text, click on the Select All button. 

  
2. Click on the Copy to Clipboard button. 
  
To close the "Metafile Records" dialog box and return to the “Specific” tab of the “Properties” dialog 
box, click on the OK button. 
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2.8.8.4 Specific tab (DIB or Flex.Win Symbol picture) 
  

 
  
This tab displays the size of the Picture, Width and Height (in Pixels). 
  
  
2.8.8.5 Colors tab 
  

 
  
From this tab you can override the original line and fill colors of the picture. 
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 To change a color: 
 
1. Click on the "Override Built-in Colors" check-box. A tick will appear in the check-box and the fields 

in the "Metafile Colors" section will become active. 
  
2. Click on the "Line color" or "Fill color" Change button as required. The Microsoft Windows “Color” 

dialog box will be displayed where you can now define required color. 
  
3. After you have defined the color, click on the OK button. The selected color will now be displayed 

on the button top.  
 
If you want your picture to have a gradient filling, click on the "Use gradient filling" check-box. A 
tick will appear in the check-box when activated. 

  
4. Click on the Preview button to preview your picture in the "Selected Picture" section. 

 To return settings to their default parameters: 
 
� Click on the Reset button. 
  
After all changes have been made to the Picture properties dialog box, click on the Apply button 
followed by the OK button to save your changes, or click on the Cancel button to close the window 
and not save changes. 
  
The Help button links you to the on-line Help and provides Help topics and tips to help you accomplish 
your tasks. 
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2.9 Help information 

2.9.1 Help (Help menu) 
 
The "Help" option from the "Help" menu links you to the on-line Help and provides topics and tips to 
help you accomplish your tasks. 

 To access the on-line Help: 
 
� From the Help menu, select the Help option.  

 

Shortcuts:   Toolbar    Keypad F1 
 
 
2.9.2 About Flex.Gallery (Help menu) 
 
Selecting "About Flex.Gallery" from the "Help" menu will display Flex.Gallery program information 
similar to the display below. 
  
Use this command to display information about the Flex.Gallery software you are using, such as; 
software version number; build number and Copyright. This information can be given to the support 
engineer in the event of a problem with Flex.Gallery. 
  
� From the Help menu, select the About Flex.Gallery option. 

 

 
  
From the "About Flex.Gallery" window, you can visit the Datac WEB site, or send an e-mail to the 
Datac Sales department to enquire about other Flex.Win and Datac products. 

 To send our Sales department an e-mail: 
 
1. Click on the sales@datac-technologies.com hyperlink. Your e-mail application will be opened 

where the Datac contact address will be entered automatically. 
  
2. Type in your query or request and send the e-mail to us in the normal way. 

 To visit the DATAC Technologies Limited WEB site: 
 
� Click on the www.datac-technologies.com hyperlink. Your WEB browser will be opened and the 

Datac WEB site will be dialled. 
  
See also, Section 2.5.5, “Product Info window”. 
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3 Menus 

3.1 File menu commands 

The "File" menu offers the following commands: 
  
Options - Allows you to define the Flex.Gallery Application preferences. For details, please refer to 
Section 2.5.1. 
  
Exit - Exits the Flex.Gallery program. For details, please refer to Section 2.2.4. 
 
 
3.2 Gallery menu commands 

The "Gallery" menu offers the following commands: 
  
New... - Allows you to create a new Gallery. For details, please refer to Section 2.6.1. 
  
Open... - Allows you to open an existing Gallery. For details, please refer to Section 2.6.2. 
  
Save As... - Allows you to overwrite an existing Gallery with a copy of the currently open Gallery or 
to save the currently open Gallery under a new name. For details, please refer to Section 2.6.3. 
 
 
3.3 Category menu commands 

The "Category" menu offers the following commands: 
  
New... - Allows you to add a new Category. For details, please refer to Section 2.7.1. 
  
Delete - Allows you to remove an existing Category from the hierarchy list of Category groups. For 
details, please refer to Section 2.7.2. 
  
Import... - Allows you to import a previously saved Category and its contents of pictures from file. For 
details, please refer to Section 2.7.3. 
  
Export... - Allows you to save a Category and its contents of pictures to file. For details, please refer to 
Section 2.7.4. 
  
Import Flex.Win Symbol Library... - Allows you to import a Flex.Win Symbol Library. For details, 
please refer to Section 2.7.5. 
  
Edit Name... - Allows you to rename an existing Category. For details, please refer to Section 2.7.6. 
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3.4 Picture menu commands 

The "Picture" menu offers the following commands: 
  
Cut - Allows you to remove pictures from the Category list and copy them to the Clipboard. For details, 
please refer to Section 2.8.3. 
  
Copy - Allows you to copy a picture onto the Clipboard. For details, please refer to Section 2.8.2. 
  
Paste - Allows you to paste the contents of the Clipboard into a Category group. For details, please 
refer to Section 2.8.5. 
  
Delete - Allows you to remove pictures from the Category list. For details, please refer to Section 
2.8.4. 
  
Select All - Allows you to select all the pictures in a Category group. For details, please refer to 
Section 2.4.2.1. 
  
Import... - Allows you to import previously saved pictures from file. For details, please refer to Section 
2.8.7. 
  
Export... - Allows you to save pictures to file. For details, please refer to Section 2.8.6. 
  
Properties... - Allows you to show the Picture properties window. For details, please refer to Section 
2.8.8. 
 
 
3.5 View menu commands 

The "View" menu offers the following commands: 
  
Standard Toolbar - Enables/Disables the Standard toolbar. For details, please refer to Section 
2.2.3.3. 
  
Picture Toolbar - Enables/Disables the Picture toolbar. For details, please refer to Section 2.2.3.4. 
 
 
3.6 Help menu commands 

The "Help" menu offers the following commands: 
  
Help - Links you to the on-line Help. For details, please refer to Section 2.9.1. 
  
About Flex.Gallery - Displays Flex.Gallery program information. For details, please refer to Section 
2.9.2. 
 



Flex.Gallery V3.1 Help Manual 

5000-0001-0042-D 

 Page 56 of 61

 

Index 
.bmp files ............................................................................................................................................... 44 
.emf files ................................................................................................................................................ 44 
.fgc files.................................................................................................................................................. 35 
.lib files................................................................................................................................................... 37 
.mbv Gallery files ................................................................................................................................... 28 
.wmf files................................................................................................................................................ 44 

A 
About - Flex.Gallery............................................................................................................................... 51 
Add - Imported pictures ......................................................................................................................... 44 

New Categories ................................................................................................................................. 33 
New Gallery ....................................................................................................................................... 28 
New pictures ...................................................................................................................................... 44 
Picture to your Flex.Builder display ................................................................................................... 39 

Alt+Enter - Picture Properties shortcut .................................................................................................. 46 
Alt+F4 - Exit Flex.Gallery shortcut......................................................................................................... 13 
Application window................................................................................................................................ 21 

B 
Bitmap pictures - Copying ..................................................................................................................... 23 

C 
Category - Delete .................................................................................................................................. 33 

Edit name........................................................................................................................................... 38 
Export................................................................................................................................................. 35 
Hierarchy area ................................................................................................................................... 16 
Import ................................................................................................................................................. 34 
Import Flex.Win Symbol Library......................................................................................................... 37 
Menu commands ............................................................................................................................... 53 
New.................................................................................................................................................... 33 
Picture thumbnail area ....................................................................................................................... 16 
Selecting ............................................................................................................................................ 18 

Category menu - Commands ................................................................................................................ 53 
Delete................................................................................................................................................. 33 
Edit Name... ....................................................................................................................................... 38 
Export................................................................................................................................................. 35 
Import Flex.Win Symbol Library......................................................................................................... 37 
Import... .............................................................................................................................................. 34 
New... ................................................................................................................................................. 33 

Clipboard - Copy picture(s) to ............................................................................................................... 39 
Paste picture(s) from.......................................................................................................................... 40 

Clipboard Options window..................................................................................................................... 23 
Closing - Flex.Gallery ............................................................................................................................ 13 

Toolbars ............................................................................................................................................. 11 
Colors - Overriding ................................................................................................................................ 46 
Commands - Category menu ................................................................................................................ 53 

File menu ........................................................................................................................................... 53 
Gallery menu...................................................................................................................................... 53 
Help menu.......................................................................................................................................... 54 
Picture menu...................................................................................................................................... 54 
View menu ......................................................................................................................................... 54 

Copy - Bitmap as... ................................................................................................................................ 23 
Flex.Win symbol as............................................................................................................................ 23 
Matafile as.......................................................................................................................................... 23 
Picture ................................................................................................................................................ 39 

Create - New Gallery ............................................................................................................................. 28 
Ctrl+A - Select all Pictures shortcut....................................................................................................... 19 
Ctrl+C - Copy Picture shortcut............................................................................................................... 39 



Flex.Gallery V3.1 Help Manual 

5000-0001-0042-D 

 Page 57 of 61

 

Ctrl+Enter - Flex.Gallery options shortcut ............................................................................................. 20 
Ctrl+V - Paste Picture(s) shortcut.......................................................................................................... 40 
Ctrl+X - Cut Picture shortcut.................................................................................................................. 39 
Cut - Picture........................................................................................................................................... 39 

D 
Datac WEB site ............................................................................................................................... 27, 51 
Del - Delete Picture(s) shortcut ............................................................................................................. 40 
Delete - Category .................................................................................................................................. 33 

Picture(s)............................................................................................................................................ 40 
Dialog box - Export category ................................................................................................................. 36 

Export Picture .................................................................................................................................... 43 
Import category .................................................................................................................................. 35 
Import Flex.Win Symbol Library......................................................................................................... 37 
Import Picture..................................................................................................................................... 45 
New gallery ........................................................................................................................................ 28 
Open gallery....................................................................................................................................... 29 
Save Gallery As ................................................................................................................................. 31 

Dynamic Symbols - Foreground color ................................................................................................... 21 

E 
Edit category name................................................................................................................................ 38 
E-mail Datac .................................................................................................................................... 27, 51 
Enable/Disable - Product interface language translation ...................................................................... 25 
Entering data ......................................................................................................................................... 14 
Exiting Flex.Gallery................................................................................................................................ 13 
Expandable/collapsible hierarchy area.................................................................................................. 16 
Export - Category .................................................................................................................................. 35 

Picture ................................................................................................................................................ 41 
Export category dialog box.................................................................................................................... 36 
Export picture dialog box................................................................................................................. 41, 43 

F 
F1 - On-line Help shortcut ..................................................................................................................... 51 
F3 - Import Picture(s) shortcut............................................................................................................... 44 
F4 - Export Picture(s) shortcut .............................................................................................................. 41 
File - Gallery .mbv ................................................................................................................................. 28 

Menu commands ............................................................................................................................... 53 
File formats.............................................................................................................................................. 7 
File menu - Commands ......................................................................................................................... 53 

Exit ..................................................................................................................................................... 13 
Options............................................................................................................................................... 20 

Fill - Gradient ......................................................................................................................................... 46 
Flex.Builder - Adding pictures from the Gallery..................................................................................... 39 
Flex.Gallery - About............................................................................................................................... 51 

Application window ............................................................................................................................ 16 
Overview .............................................................................................................................................. 7 
Starting................................................................................................................................................. 9 
Status bar........................................................................................................................................... 11 
Title bar .............................................................................................................................................. 10 

Flex.Win Project Symbol Library importing ........................................................................................... 37 
Flex.Win Symbols - Copying ................................................................................................................. 23 
Foreground color for Dynamic symbols................................................................................................. 21 

G 
Gallery - Overwriting an existing Gallery ............................................................................................... 30 

Saving under a new name ................................................................................................................. 30 
Gallery menu - Commands.................................................................................................................... 53 

New... ................................................................................................................................................. 28 



Flex.Gallery V3.1 Help Manual 

5000-0001-0042-D 

 Page 58 of 61

 

Open... ............................................................................................................................................... 29 
Save As.............................................................................................................................................. 30 

GDI code records .................................................................................................................................. 46 
Gradient filling........................................................................................................................................ 46 

H 
Help menu - Commands........................................................................................................................ 54 

About Flex.Gallery ............................................................................................................................. 51 
Help.................................................................................................................................................... 51 

Help topics............................................................................................................................................. 51 

I 
Import - Category................................................................................................................................... 34 

Category dialog box ........................................................................................................................... 35 
Flex.Win Symbol Library .................................................................................................................... 37 
Flex.Win Symbol Library dialog box .................................................................................................. 37 
Picture ................................................................................................................................................ 44 
Picture dialog box .............................................................................................................................. 45 

Import Pictures dialog box..................................................................................................................... 44 

L 
Language options window..................................................................................................................... 25 

M 
Making choices...................................................................................................................................... 14 
Maximizing a window............................................................................................................................. 14 
Metafile pictures - Copying.................................................................................................................... 23 

Details ................................................................................................................................................ 46 
Minimizing a window.............................................................................................................................. 14 
Moving - a window................................................................................................................................. 14 

Toolbars ............................................................................................................................................. 11 

N 
Name of Picture..................................................................................................................................... 46 
New - Category...................................................................................................................................... 33 

Gallery................................................................................................................................................ 28 
Gallery dialog box .............................................................................................................................. 28 

New Category dialog box ...................................................................................................................... 33 

O 
Open - Gallery ....................................................................................................................................... 29 

Toolbars ............................................................................................................................................. 11 
Open Galley dialog box ......................................................................................................................... 29 
Options - Application window ................................................................................................................ 21 

Clipboard options window.................................................................................................................. 23 
Language window .............................................................................................................................. 25 
Picture list........................................................................................................................................... 21 
Preview .............................................................................................................................................. 21 
Product info window........................................................................................................................... 27 
Selecting ............................................................................................................................................ 20 

Override built-in colors........................................................................................................................... 46 
Overview.................................................................................................................................................. 7 
Overwrite - An existing Gallery.............................................................................................................. 30 

P 
Paste picture.......................................................................................................................................... 40 
Paste Pictures dialog box...................................................................................................................... 40 
Picture - Copy........................................................................................................................................ 39 

Cut...................................................................................................................................................... 39 



Flex.Gallery V3.1 Help Manual 

5000-0001-0042-D 

 Page 59 of 61

 

Delete................................................................................................................................................. 40 
Export................................................................................................................................................. 41 
Import ................................................................................................................................................. 44 
Metafile details ................................................................................................................................... 46 
Name.................................................................................................................................................. 46 
Paste .................................................................................................................................................. 40 
Properties........................................................................................................................................... 46 
Renaming........................................................................................................................................... 46 
Selecting ............................................................................................................................................ 18 
Selecting All ....................................................................................................................................... 19 
Size .................................................................................................................................................... 46 
Toolbar ............................................................................................................................................... 12 
Type ................................................................................................................................................... 46 

Picture menu - Commands.................................................................................................................... 54 
Copy................................................................................................................................................... 39 
Cut...................................................................................................................................................... 39 
Delete................................................................................................................................................. 40 
Export................................................................................................................................................. 41 
Import... .............................................................................................................................................. 44 
Paste .................................................................................................................................................. 40 
Properties........................................................................................................................................... 46 
Select All ............................................................................................................................................ 19 

Picture Properties dialog box ................................................................................................................ 46 
Pictures list options................................................................................................................................ 21 
Preview options - Background color...................................................................................................... 21 
Product Info options window.................................................................................................................. 27 
Project - Symbol Library importing ........................................................................................................ 37 
Properties - Picture................................................................................................................................ 46 

R 
Renaming - Category ............................................................................................................................ 38 

Picture ................................................................................................................................................ 46 
Resizing a window................................................................................................................................. 14 

S 
Sales@datac-technologies.com hyperlink ............................................................................................ 51 
Save As - Gallery................................................................................................................................... 30 
Save Gallery As dialog box ................................................................................................................... 31 
Scroll bars.............................................................................................................................................. 14 
Select - All pictures................................................................................................................................ 19 

Categories.......................................................................................................................................... 18 
Options............................................................................................................................................... 20 
Pictures .............................................................................................................................................. 18 

Selected picture preview and details area............................................................................................. 16 
Send - E-mail ................................................................................................................................... 27, 51 
Shift+D - Delete Category shortcut........................................................................................................ 33 
Shift+E - Edit Category name shortcut .................................................................................................. 38 
Shift+F3 - Import Category shortcut ...................................................................................................... 34 
Shift+F4 - Export Category shortcut ...................................................................................................... 35 
Shift+F5 - Import Flex.Win Symbol Library shortcut.............................................................................. 37 
Shift+N - New Category shortcut........................................................................................................... 33 
Size - Picture ......................................................................................................................................... 46 
Standard Tools ...................................................................................................................................... 12 
Starting the Flex.Gallery program ........................................................................................................... 9 
Status bar .............................................................................................................................................. 11 
Symbol Library - Importing .................................................................................................................... 37 

T 
Thumbnails of pictures .......................................................................................................................... 16 
Title bar.................................................................................................................................................. 10 



Flex.Gallery V3.1 Help Manual 

5000-0001-0042-D 

 Page 60 of 61

 

Toolbar - Closing ................................................................................................................................... 11 
Moving................................................................................................................................................ 11 
Opening.............................................................................................................................................. 11 
Overview ............................................................................................................................................ 11 
Picture ................................................................................................................................................ 12 
Standard............................................................................................................................................. 12 

Transfer pictures.................................................................................................................................... 39 
Type - Picture ........................................................................................................................................ 46 

U 
Using - Flex.Gallery windows ................................................................................................................ 14 

Product specific language settings .................................................................................................... 25 

V 
View menu - Commands ....................................................................................................................... 54 

Picture Toolbar................................................................................................................................... 12 
Standard Toolbar ............................................................................................................................... 12 

Viewing - Images in the Gallery............................................................................................................. 16 
Pictures .............................................................................................................................................. 16 

W 
Web Server button................................................................................................................................. 27 
Window - Maximizing............................................................................................................................. 14 

Minimizing .......................................................................................................................................... 14 
Moving................................................................................................................................................ 14 
Resizing ............................................................................................................................................. 14 
Restoring............................................................................................................................................ 14 
Scroll bars .......................................................................................................................................... 14 

www.datac-technologies.com hyperlink ................................................................................................ 51 
 
 



Flex.Gallery V3.1 Help Manual 

5000-0001-0042-D 

 Page 61 of 61

 

 


